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ADOBE® CONNECT™

This quick reference guide will get you started using Adobe 
Connect, whether you are creating and hosting a meeting, 
presenting at a meeting, or simply attending a meeting. 
The guide includes:

• Visual Quick Start Guide ............................................ page   1
• Preparing for a meeting ............................................ page   3
• Operating a Meeting .................................................. page   8
• Being a Presenter ...................................................... page 11
• Attending a Meeting .................................................. page 11

For a full user guide and more materials please refer to
the Adobe Connect page in the training section on
help.case.edu. For additional assistance, contact the ITS 
Service Desk at 216.368.HELP (4357). To request training, 
email help@case.edu

VISUAL QUICK START GUIDE

PARTCIPATE IN ADOBE CONNECT MEETINGS

Adobe Connect is an enterprise web conferencing solution 
for online meetings, eLearning and
webinars used by leading corporations and government 
agencies. This Visual Quick Start Guide
provides you with the basics participating in an Adobe Con-
nect meeting, virtual
classroom, or webinar.

ATTEND AN ADOBE CONNECT MEETING
 
1. It is recommended that you test your computer prior 

to attending a meeting. You can do this by going to 
http://admin.adobeconnect.com/common/help/en/
support/meeting_test.htm

2. The Connection Test checks your 
computer to make surevall 
system requirements are met. 
If you pass the first three steps 
of the test, then you are ready to participate in a 
meeting.

Tip: The fourth step of the Connection Test is for the Adobe 
Connect Add-in which is only required for meetings 
Hosts and Presenters who need to share their screen. 
Installing the add-in is not required, but may enhance 
your meeting experience.

3. If you do not pass the test, perform the suggested 
actions and run the test again.

JOIN A MEETING

1. You have likely received an 
email invitation with 
meeting access 
information. When the 
meeting time arrives, 
click on the link or enter
the URL into your favorite web browser.

2. The meeting login screen 
appears. Type in your
Case ID and Password and 
then click Enter Room.

3. The meeting launches in 
your browser. If the meeting
 host has not yet arrived to 
the meeting or meeting 
security requires the host 
to approve your attendance,
 you will be placed in a waiting area.

4. Once the meeting host accepts you into the
meeting, the meeting room interface appears.

VOICE-OVER-IP (VoIP)

With Voice over IP, you
can hear audio through 
your computer speakers. 
If a meeting attendee is 
speaking using VoIP, you 
will see a microphone 
icon next to their name.

In some cases, meeting 
hosts may give you the
ability to broadcast 
audio using VoIP. When 
this is the case, a dialog 
will alert you that you have the rights to use your
microphone. Clicking the Speak Now link will activate the
microphone icon in the Application Bar at the top of 
your screen.

Tip: Before each meeting, it is recommended that you 
run through the Audio Setup Wizard to optimize your 
experience. To do this, select ‘Audio Setup Wizard...’ 
from the Meeting menu.
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SHARE WEBCAM VIDEO

The meeting host may ask you 
to use your webcam to share 
video. When this is the case, 
a button enabling you to share 
your webcam will appear on 
the video pod. To share your 
camera, make sure your web 
cam is plugged in and click the 
Share My Webcam button. 
Adobe Flash may prompt you for permission. After granting 
permission, a webcam video preview appears. If you’re happy 
with the preview, click Start Sharing to share your video with 
all participants.

You can also click the webcam icon  in the Application 
Bar to access your webcam and preferences.

CHANGE YOUR STATUS

Within a meeting, you can also 
change your status to provide 
feedback to the presenter and 
other attendees.

To change your status, click the 
arrow on the Status Options 
dropdown list on the 
Application Bar and select
your desired status option.

If you select an option above the line such as Agree or Step
Away, you status remains until you choose Clear Status.
If you choose an option below the line such as Speed Up
or Applause, your status automatically clears itself after a
number of seconds.

When you set your status, an icon appears next to your
name in the Attendees pod. 

Note : you need to clear your status when appropriate or it 
will remain active.

CHAT

To send a message to everyone, 
simply type your message in the
chat pod and hit enter or click 
the send icon.

TROUBLESHOOTING

Issue Solution
I cannot
get into the
meeting

If you are having trouble joining a 
meeting try the following:

1. Enter the meeting as a Guest user by 
entering in your First and Last
Name in the Guest field.
2. Click the Help link on the Meeting 
Login page. This takes you to
the Test Meeting Connection page 
where you can verify that your
computer meets all necessary require-
ments. If you do not pass the test
you will be given instructions for what 
you need to do.
3. Make sure popup blocking software 
is not blocking your meeting
window.
4. You may be using a proxy server. To 
resolve this in Internet Explorer,
select Tools > Internet Options > Ad-
vanced tab. Then enable the
setting Use HTTP 1.1 through proxy 
connections. After doing this, clear
your cookies, close all browser windows 
and attempt to re-enter the
meeting.

I cannot
hear any
audio

1. Verify that your computer speakers 
are on and your computer’s
volume is at an audible level.
2. Check to see if the meeting host has 
provided teleconference
information. If this is the case, you need 
to dial in via telephone to hear
meeting audio.
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Issue Solution
I have been
granted
rights to
speak, but
no one can
hear me

If you are having trouble sharing your 
voice try the following tasks:
1. Make sure your computer micro-
phone is not muted.
2. Run through the Audio Setup Wizard. 
To do this, select Meeting
> Audio Setup Wizard. The wizard 
guides you through five steps in
which your computer is tuned for opti-
mal VoIP.
3. You may have elected to deny the 
Flash Player access to your
computer’s microphone. To verify this, 
right click in the meeting
window and choose Settings to view 
your Flash Player settings. In the
dialog box, choose Allow.

The host is
sharing 
their
screen, but
it is fuzzy

If you are having trouble seeing a hosts 
screen, try the following:
1. Click the Full Screen button on the 
top of the Share pod.
2. View the full resolution by using the 
pod options menu in the top
right hand corner of the pod to select 
Change View > Zoom In.

LEARN MORE

You can find additional resources by visiting the Adobe 
Connect User Community at www.connectusers.com

PREPARING FOR A MEETING
This section of the Quick Reference Guide will assist you with 
creating a meeting, adding participants, sending invitations, 
and other duties of the meeting host.

CREATING A MEETING

1. Log in to connect.case.edu with your CWRU Network ID 
and password.

2. Your Connect homepage appears. Click the Meeting 
button to create a new meeting.

3. Name: Enter a name for the meeting into the Name field.

4. Custom URL: To specify a URL for the meeting room, 
enter an appropriate name or abbreviation for the 
meeting into the Custom URL field. If the field is left 
blank, Connect will assign a random, unique URL to the 
meeting.

5. Select Template: Do not change the contents of the 
Select Template menu.

6. Access: The Access option defaults to Only registered 
users and accepted guests may enter the room. If 
you plan to invite people to your meeting who are not 
members of the CWRU community, select the option 
for Anyone who has the URL for the meeting can enter 
the room. See “Restrict Access to a Meeting” for more 
information on limiting guest access.

7. Click the Finish button. 
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ADD PARTICIPANTS TO A MEETING

1. From the Connect homepage, click the Meeting tab at 
the top of the screen.

2. Locate your meeting in the list. Click on its name.

3. Click the Edit Participants link.

4. Click the Search button to activate the Search field.

5. Enter the name of a participant into the search box. 
When the individual’s name appears in the search 
results, double-click on the name. Repeat this process 
for all participants.

6. The participant’s name will be added to the Current 
Participants box.

CHANGE PARTICIPANT ROLES

1. From the Connect homepage, click the Meeting tab at 
the top of the screen.

2. Locate your meeting in the list. Click on its name.

3. Click the Edit Participants link.

4. Click on the participant’s name in the Current 
Participants box and click the Set User Role button.

5. Select the appropriate role for that participant from the 
list that appears:

Participant: Can use all pods except for Camera and Voice 
and Sharing.

Presenter: Can use all pods, share content and share their 
desktop.

Host: Can use all pods, change the layout of the meeting 
room, give participants the right to use audio/video, change 
participant/presenter roles, and request to share other 
participants’ desktops.

SEND INVITATIONS TO PARTICIPANTS

1. From the Connect homepage, click the Meeting tab at 
the top of the screen.

2. Locate your meeting in the list. Click on its name.

3. Click the Invitations link.

4. The Invitations screen allows you to send email 
invitations to hosts, presenters, and participants. If you 
prefer to send an email through another application, 
such as webmail.case.edu, copy the hyperlink listed in 
the To join the meeting field and paste it into an email 
message.

5. The Message Body field contains a default message. Add 
or remove content as desired.

6. Click the Send button to send the email. 

http://webmail.case.edu
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ADD CONTENT TO A MEETING

Content includes PDF files, PowerPoint presentations, Word 
files and other media.

1. From the Connect homepage, click the Content button.

2. Click the New Content button.

3. Click the Browse/Choose File button to select a file on 
your computer to load into Connect.

4. Title: Enter a name for the content into the Title field.

5. Custom URL: Enter a URL for this content that can be 
used to access it outside of a meeting, or leave the field 
blank to have Connect assign a random, unique URL to 
the content.

6. Click the Save button.

7. Click the Meetings tab at the top of the screen.

8. The Meeting List appears. Click on the name of your 
meeting.

9. Click the Enter Meeting Room button.

10. The Meeting Room appears. Locate the Share pod. Click 
the Share My Screen dropdown button to activate the 
menu.

11. Click the Share Document list item. Choose My Content 
from the list and select the content that you wish to 
load into the meeting. Note: You can also add additional 
content to the meeting by clicking the Browse My 
Computer button and locating the appropriate file.

12. The file appears in the Share pod, where it will be seen 
by all participants in the meeting. To remove the content 
from the sharing pod, click the Stop Sharing button.

EDIT A MEETING ROOM’S LAYOUT

Meeting rooms are composed of Pods that serve different 
functions, such as hosting a webcam video, chat, listing 
meeting attendees, sharing files, displaying media, 
conducting polls and taking notes.

1. From the Connect homepage, click on My Meetings, 
locate the meeting you wish to open, click on the name 
and click the Enter Meeting Room button.

2. The default view for CWRU meetings is the Sharing 
layout. It includes the following pods:

• Attendee List
• Notes
• Chat
• Sharing

3. To change the layout, click the Layout menu. Select the 
Collaboration or Discussion layout.
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The Collaboration layout includes the following pods:
• Video
• Attendees
• Notes
• Whiteboard
• Chat
• Fileshare

The Discussion Layout includes the following pods:
• Attendees
• Notes
• Video
• Chat
• Poll
• Discussion Notes

ADD, HIDE OR CHANGE PODS IN A LAYOUT

1. From the Connect homepage, click on My Meetings, 
locate the meeting you wish to open, click on the name 
and click the Enter Meeting Room button.

2. In the meeting room, click the Pods menu. A list of 
available pods appears. Items with a checkmark to their 
left are already open. Items without a checkmark are 
closed.

3. To add a pod to the layout, click on its name in the Pods 
menu. If the pod name has an arrow on its right, it has 
additional options that will appear and give you the 
option to activate an existing pod or create a new one. 
Select an option to make the pod appear in the meeting 
room.

4. Make changes to pods as desired.
• To change a pod’s name, double-click on the
name with your left mouse button and type the
desired text.
• To move a pod, click near its title and drag it to
another area on the screen.
• To resize the pod, hover your mouse cursor over
one of its corners and drag the pod to the
desired size.

5. Pod options: Click the Pod Options button to see options 
for the pod selected.

CONFIGURE AUDIO SETTINGS

1. From the Connect homepage, click on My Meetings, 
locate the meeting you wish to open, click on the name 
and click the Enter Meeting Room button.

2. Click the Meeting menu. Click Audio Setup Wizard.

3. The Audio Setup Wizard window appears. Ensure that 
your audio device (e.g. microphone, headset) is plugged 
into your machine. Click the Next button.

4. Click the Play Sound button. An audio test begins. Listen 
for music coming from your speakers or headset.

5. If you do not hear sound once the test has completed, 
click the Help button. If the test was successful, click the 
Next button.

6. Click the dropdown menu to select the microphone that 
you will use during the meeting. To use your default 
device, do nothing. Click the Next button.
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7. Test your microphone by clicking the Record button and 
speaking at a normal level. A Flash Player permission 
request may appear. If it does, click the Allow button. 
Click the Stop button to complete the microphone test. 
If you do not hear sound when you click the Play button, 
click the Help button for assistance. If the test was 
successful, click the Next button.

8. Click the Test Silence button and remain silent until the 
test is finished. When complete, click the Next button.

9. If the audio setup wizard did not completely set up your 
audio device, click the Help button for guidance. Click the 
Finish button to complete the Audio Wizard.

CONFIGURE WEBCAM SETTINGS

1. From the Connect homepage, click on My Meetings, 
locate the meeting you wish to open, click on the name 
and click the Enter Meeting Room button.

2. Click the Webcam button at the top of the meeting room. 
In the Video pod, click the Pod Options button and select 
the Camera list item.

3. The Adobe Flash Player Settings window appears. 
Confirm that your webcam is displayed in the Camera 
field, or select the appropriate camera from the list. Click 
the Close button.

4. Click the Pod Options button and select the Preferences.

5. The Preferences window appears and displays the 
Video Settings page. The Video Quality setting is set at 
the appropriate level for the bandwidth allotted to the 
meeting room; however, it can be changed as desired to 
decrease or increase speed and/or video quality. Click 
the Done button.

6. When you are ready to use the webcam, click the Start 
My Webcam button. If the webcam preview is in the pod, 
click the Start Sharing button. A Flash Player permission 
request may appear. If it does, click the Allow button.

7. A small preview of your image appears in the Camera 
and Voice pod. Click the Start Sharing button to begin 
sharing your webcam video with the rest of the meeting 
room. Click the Stop My Webcam button to stop the 
broadcast of your webcam video to the rest of the 
meeting room.

RESTRICT ACCESS TO A MEETING

In addition to setting Access rights to a meeting (see 
“Creating a Meeting”), hosts also have the ability to determine 
if participants and guests can enter a meeting room when it 
is open. Hosts can choose to block all incoming participants 
or require them to request access to the meeting room.

1. From the Connect homepage, click on My Meetings, 
locate the meeting you wish to open, click on the name 
and click the Enter Meeting Room button.

2. Click the Meeting menu, point to Manage Access & Entry, 
and click Block Incoming Attendees.

3. The Block Incoming Attendees window appears. Optional: 
Click the Incoming attendees can request entry option 
to allow incoming attendees to request access to the 
meeting.

4. The Message for Incoming Attendees text box contains 
a default message that will appear to guests and invited 
participants when they attempt to open the meeting.
Change or make updates to this message if desired.

5. Click the OK button.
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6. A message will appear at the top right corner, a blinking 
. Click the arrow to view the message. The settings 

can be changed from this message.

7. When a participant wants to access the meeting room, 
another pop-up window will appear. Click the Decline or 
Accept link to deny or grant the individual access to the 
room. 

OPERATING A MEETING
This section of the Quick Reference Guide will assist you with 

operating a meeting as its host.

OPEN A MEETING

1. Log in to connect.case.edu with your CWRU Network ID 
and password.
Alternate: Enter the URL of the meeting room into the 
address bar of your internet browser. Go to step 4

2. Click on My Meetings, locate the meeting you wish to 
open, and click the Open button.

Alternate: Click the Meetings tab. Go to step 7

3. The meeting room will appear. You may be required 
to install the Adobe Connect add-in if you are on a 
computer that has not used Connect previously.

End of Procedure. Remaining steps apply to alternate 
path from step 1.

4. The Connect login screen appears. Click the Enter with 
your login and password option.

5. Enter your CWRU Network ID and Password. Click the 
Enter Room button.

6. The meeting room will appear. You may be required 
to install the Adobe Connect add-in if you are on a 
computer that has not used Connect previously.

End of Procedure. Remaining steps apply to path from 
step 2.

7. Click on the name of your meeting.

8. Click the Enter Meeting Room button.

9. The Meeting room will appear. You may be required 
to install the Adobe Connect add-in if you are on a 
computer that has not used Connect previously. 

CHANGE PARTICIPANTS’ ROLES AND RIGHTS

Meeting participants can use all pods except for Video and 
Sharing. To give participants the right to use these pods, you 
can make them Presenters or Hosts. You can also expressly 
grant audio and video rights. or remove content as desired.

1. In the meeting, click the participant’s name on the 
Attendees pod. A pop-up menu appears that includes 
the following options:

Enable Audio: gives the participant the right to use a 
microphone to speak.

Enable Video: gives the participant the right to use a 
webcam.

Make Host: gives the participant the rights to use all 
pods, change the layout of the meeting room, give 
other participants the right to use audio/video, change 
participant roles, and request to share other participants’ 
desktops.

Make Presenter: gives the participant the right to use 
all pods (including sharing content or the desktop in the 
Sharing pod), audio, video.

http://connect.case.edu
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2. To remove any of these rights, hover your mouse cursor 
over the participant’s name to make the pop-up menu 
appear and select the appropriate option.

Note: You can also drag and drop participants’ names 
into the Host, Presenter and Participant roles within the 
Attendees pod.

GIVE ALL PARTICIPANTS AUDIO RIGHTS

Giving all participants the right to use audio enables 
everyone in the room to utilize the microphone button to 
speak in the meeting.

1. In the meeting, click the Audio menu and select Enable 
Audio For Participants.

2. A checkmark will appear to the left of the Enable Audio 
for Participants menu item.

3. To disable audio rights for all participants, click on Audio 
and click on Microphone Rights for Participants. This will 
remove the checkmark and disable the “microphone” 
button for all participants.

USING THE PRESENTER ONLY AREA

The Presenter Only area enables meeting hosts to prepare 
pods for use in a meeting. Participants cannot see this area.

1. In the meeting, click the Meeting menu and select Enable 
Presenter Only Area.

2. A black area appears at the right side of the meeting 
room. The area can be resized as needed. Pods can be 
dragged from the meeting into the Presenter Only area, 
or added from the Pods menu.

3. When a new pod is added to the meeting, it will 
automatically appear in the Presenter Only area. Prepare 
the pod here (e.g., set up poll questions, upload content 
to share in a new Share pod, or upload files to a File 
Share pod).

4. When you have prepared the pod, move it into the 
meeting area by clicking on it and dragging it with your 
mouse cursor to its desired location in the meeting 
room. The meeting participants can then see the pod in 
the meeting window.

5. To disable the Presenter Only area, click the Meeting 
menu and select Disable Presenter Only Area.

CREATE A LAYOUT IN PREPARE MODE

Prepare mode allows hosts and presenters to create or 
modify a meeting room layout while the meeting is taking 
place, but without the participants seeing the changes until 
the host makes the changes visible.

1. In the meeting, click the Meeting menu and select Switch 
to Prepare Mode. A pop-up appears to alert you that 
Prepare mode is active.

2. To add a layout, click the Layout menu and select Create 
New Layout.

3. The Create a New Layout window appears. You are 
given the choice to create a blank layout or start with a 
duplicate of an existing layout. If you choose to duplicate 
an existing layout, select the layout you wish to copy 
from the list.

4. Enter a Name for this Layout: Give the layout a name. 
You may want to name the layout after a class, lesson, 
or date depending on how you intend to use the layout in 
the future.

5. Click the OK button.

6. You can now begin adding pods to the layout and making 
changes to existing pods. See “Add, Hide or Change Pods 
in a Layout” for directions.

7. When you are done preparing the new layout, click the 
Meeting menu and select End Prepare Mode. This will 
turn off Prepare mode and return you to the layout in 
which the meeting is currently operating If you made 
changes to existing pods, the changes will take effect for 
meeting participants.
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8. To activate the new layout, click the Layouts menu and 
select the new layout. The meeting room will transform 
for participants.

RECORD A MEETING

1. In the meeting, click the Meeting menu and select Record 
Meeting.

2. The Record Meeting box appears. The meeting’s name 
defaults to the title given to the meeting room. Change 
the meeting name if desired to match information such 
as the class section or meeting date in the Name field.

3. Click the OK button. The meeting will begin to record 
immediately. A message appears at the top of the 
meeting room to show that the meeting is being 
recorded.

4. When you are done recording the meeting, click the 
Recording graphic at the top right of the meeting room 
and click Stop Recording.

END A MEETING

Connect meetings can be left open indefinitely or closed after 
use.

1.  In the meeting, click the Meeting menu and select End 
Meeting.

2. The End Meeting window appears. A default message 
appears in the Show this message to everyone field. 
Optional: Change this message as desired.

3. Optional: Select the Open this URL for participants option 
to display a URL when the meeting room closes. Type 
the URL into the field below it.

4. Click the OK button to close the meeting.

5. The meeting is ended and all participants are removed 
from the meeting room. As a host, you will see the 
Start Meeting button at the bottom of the window. This 
button can be used in the future to open the room again.

VIEW AND SHARE A RECORDED MEETING

There are two options for making recorded meetings 
available for viewing: recordings can be viewed in Connect, 
or saved as Flash files that can be displayed on another site 
(e.g., Blackboard Learn).

1. From the Connect homepage, click the Meeting tab at 
the top of the screen.

2. Locate your meeting in the list. Click on its name.

3. Click the Recordings link. The Recordings screen displays 
all recordings that have been made of the meeting.

4. Locate your meeting and click its checkbox. Click the 
Make Public button.

5. Click the link to the meeting. The URL for Viewing field 
displays the unique URL for viewing the meeting, which 
can be distributed to meeting participants or other 
individuals by copying the link and pasting it into an 
email.



DOWNLOAD A RECORDED MEETING

1. From the Connect homepage, click the Meeting tab at 
the top of the screen.

2. Locate your meeting in the list. Click on its name.

3. Click the Recordings link. The Recordings screen lists all 
recordings that have been made of the meeting.

4. Locate the appropriate recording and click the Make 
Offline link to save the recording as a Flash (.flv) file.

5. The Offline Recording message will pop up. Click Proceed 
with Offline Recording button to continue.

6. You will be prompted to select a name and location for 
the .flv file.

7. The Connect recording will play on your desktop. During 
this time, it is also being recorded and saved to the 
indicated location. Do not engage in activities that will 
interfere with the download at this time.

8. When the recording has finished playing, close the 
Connect meeting. The file can be found in the location 
where it was saved.

BEING A PRESENTER
This section of the Quick Reference Guide can assist you with 
the tasks commonly performed by those in the Presenter 
role or Hosts who are presenting in a meeting.

OPEN A MEETING

1. Enter the URL of the meeting room into the address bar 
of your internet browser.

2. The Adobe Connect login screen appears. Click the Enter 
with your login and password option.

3. Enter your CWRU Network ID and Password. Click the 
Enter Room button.

4. The meeting room will appear. You may be required 
to install the Adobe Connect add-in if you are on a 
computer that has not used Connect previously.

SHARE CONTENT

1. In the meeting room, locate the Share pod. Click the 
dropdown button next to the Share My Screen button.

2. Click the Share Document list item. A search window will 
appear. Click the Browse My Computer button and locate 
the appropriate file. Click the Open button.

3. The content appears in the Share pod and can be seen 
by all participants in the meeting. To remove the content 
from the Share pod, click the Stop Sharing button.

SHARE YOUR DESKTOP

1. In the meeting room, locate the Share pod. Click the 
Share My Screen button.

2. The Start Screen Sharing window appears. Select to 
share your desktop, applications or windows.

• Desktop: Shares anything that is active on your
desktop.
• Applications: Enables you to select the
applications to share.
• Windows: Enables you to select open windows
to share.

3. The Connect meeting window will minimize. Your 
desktop or selected application/window is broadcast to 
all meeting participants. To stop sharing, return to the 
Connect window and click the Stop Sharing button.

ATTENDING A MEETING
If you are invited to an Adobe Connect meeting, this section 
of the Quick Reference Guide will assist you with getting to 
and participating in the meeting.

OPEN A MEETING

1. Enter the URL of the meeting room into the address bar 
of your internet browser.

2. The Adobe Connect sign in screen will appear. Enter your 
CWRU Network ID and password and click the Enter 
Room button.

3. The meeting room opens. You will see your name listed 
in the Attendees pod. Depending on the settings for the 
meeting, you may be a presenter or participant.
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USE COMMUNICATION CONTROLS

1. In a meeting room, there are two or more controls at the 
top of the screen:

•Speaker
•Audio (appears only if you have rights to use audio)
•Raise Hand

2. Speaker: The Speaker button must be in the ON position 
in order for you to hear audio that is broadcast through 
the meeting room (rather than through a telephone 
conference number).

3. Audio: To use a microphone to communicate through 
the meeting room, click the Connect My Audio button, 
which looks like a microphone. If an Adobe Flash Player 
Settings window appears, click the Allow button. See the 
topic called “Configure Audio Settings” for directions on 
preparing your microphone.

4. Raise Hand: To raise your hand to be called upon, click 
the Raise Hand button. A “raised hand” icon will appear 
next to your name in the Attendees pod. This alerts 
the presenter that you wish to chat using the Chat 
pod. There are other notification icons that you can 
use located on the menu to the right of the Raise Hand 
button. You can also clear your status from this menu.

12 To request additional copies of the Quick Reference Guide, email help@case.edu with the title of the Quick Reference 
Guide, quantity needed, your name, department and department location.


